
3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 

 

 
DeskArtes 

3Data Expert 16.0 
 

Tutorial 4 - Generating Supports for AM 
         

 

 

 

 

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

  Page 2 

First Edition 

“3Data Expert 16.0: Tutorial 4 - Generating Supports for AM”.  

February 2026  

Copyright 

© 2026 DESKARTES. All rights reserved.  

DESKARTES reserves the right to revise this publication and to make changes from 
time to time without the obligation to notify any person of such revisions and 
changes. 

Trademarks 

The DESKARTES name and the logo are trademarks of DESKARTES Oy. Other brand 
and product names are trademarks and registered trademarks of their respective 
owners. 

Contact Address 

DESKARTES OY 

Takomotie 8 

FIN-00380 HELSINKI 

Finland 

https://www.deskartes.com 

 

 

 

 

 

 

 

 
  



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 3 

 

Table of Contents 
FOREWORD ................................................................................................................................................. 4 
LESSON 1 – LEARNING THE GRAPHICAL USER INTERFACE ......................................................................... 6 

Generating supports automatically ....................................................................................................... 6 
Examining the first supports ................................................................................................................. 9 
Optimizing parameters for a selected support area .............................................................................12 

LESSON 2 – EDITING SUPPORT GEOMETRIES MANUALLY ...........................................................................21 
Adding supports manually ...................................................................................................................21 
Deleting supports manually .................................................................................................................29 
In this exercise we will delete a whole support area as well as details inside another support area. .29 
Applying Arch command to support geometry .....................................................................................33 
Adding Side support .............................................................................................................................36 
Adding Tree support ............................................................................................................................40 

LESSON 3 - LEARNING SUPPORT PARAMETERS ..........................................................................................48 
Opening and saving support parameter files .......................................................................................48 
Editing Common support parameters ..................................................................................................50 
Editing Web support parameters .........................................................................................................55 
Editing Chain support parameters .......................................................................................................59 
Editing Point support parameters ........................................................................................................64 
Generating Tube supports ....................................................................................................................67 
Compact parameters dialog .................................................................................................................70 
Generic Support improvements with version 14.0 ...............................................................................71 

LESSON 4 - OUTPUTTING AND SLICING SUPPORTS FOR AM........................................................................74 
Saving supports STL file ......................................................................................................................74 
Saving support and part slices .............................................................................................................75 
Slicing supports and parts into one file ................................................................................................79 
Previewing Slice data ..........................................................................................................................82 

LESSON 5 – ADDITIONAL TOOLS FOR SUPPORT GENERATION .....................................................................84 
Center of Gravity calculation ..............................................................................................................84 

LESSON 6 – CONNECT TOOL ......................................................................................................................85 
Connect Tool command .......................................................................................................................85 

LESSON 7 – SAND SUPPORTS .....................................................................................................................90 
Sand Support generation ......................................................................................................................90 

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 4 

Foreword 

The 3Data Expert 16.0: Tutorial 4 - Generating Supports for AM document 
provides a tutorial to support generation module in 3Data Expert 16.0 and later 
versions. The Generic Support command enables the generation of supports for 
various AM processes, like metal, stereolithography and DLP systems.  

Additionally, the last lesson shows how to generate supports for sand-based 
systems.  

There is a wide variety of support geometries you can generate with the 3Data 
Expert support generation commands. Supports can be either open or solid (e.g. 
with volume). Solid supports can be generated for heat dissipation and warpage 
prevention with metal-based AM processes. Open and delicate support structures 
can be generated for DLP or stereolithography parts. Web, Chain and Point 
supports can be used to support different areas in the part, like large downfacing 
surfaces, sharp edges and local minimum points in the part. Supports can even be 
converted to small tubes for special medical model manufacturing, like tooth 
implants.  Side supports and Arch supports can be used to prevent part movement 
during the build or to avoid hitting part surface area below the areas needing 
supports. Tree supports can be generated for parts with special geometries, like 
rings and other jewelry products in metal. Supports can be generated both fully 
automatically and optimized with manual commands.  

To get most of the tutorial lessons you should go through the examples with 3Data 
Expert 16.0. If no hard copy of the tutorial is available, we recommend you open 
3Data Expert and tutorial document side by side on the computer screen: 

 

 

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 5 

You will need a licensed version of 3Data Expert for the lessons. The functionality 
described in this tutorial can be tested with DeskArtes 3Data Expert software 
release version 14.0.0.5 or later (Help > About 3Data Expert). 

You can also use DeskArtes 3Data Expert to generate supports for sand process 
parts. More on Sand Support command can be found in the application Help and 
Tutorial 4 - Generating Supports for AM.  

Full tutorial set for 3Data Expert contains several documents which cover different 
aspects of model repair, coloring and print preparation. The tutorials are available 
in the software distribution package through the Help > Tutorial Documents menu:  

⚫ 3Data Expert 16.0: Quick Start Guide gives a short introduction to model 
repair and splitting for 3D Printing with 3Data Expert. Estimated completion 
time 15 minutes. 

⚫ 3Data Expert 16.0: Tutorial 1 - Working with 3D Models introduces basic 
viewing, measuring, automatic repair, split, connect, hollow, offset, 3D Text, 
Boolean, cut, reduce, 3D nesting, surface triangulation and other model 
manipulation functions available for STL files. Estimated completion time is 
3 hours.  

⚫ 3Data Expert 16.0: Tutorial 2 - Working with Colors introduces basic 
automatic repair and coloring for 3D Color Printer users. For 3Data Expert 
Base, Lite and Color. Estimated completion time is 1 hour.  

⚫ 3Data Expert 16.0: Tutorial 3 - Separating Shells describes the use of Shell 
Separation commands in 3Data Expert. These commands enable 
separating a part into several shells for different material (shore value) or 
color definitions in a single part. For 3Data Expert Base only. Estimated 
completion time is 30 minutes.  

⚫ 3Data Expert 16.0: Tutorial 4 - Generating Supports for AM explains the use 
of new Generic Supports command and Sand Supports command. The 
support generator can be used to generate supports for DLP, metal, 
stereolithography and sand-based processes. Adding extra connectors to 
prevent parts from warping and bending during the build is explained. Also, 
new slicing, slice preview and slice filling is demonstrated. Estimated 
completion time 1 hour.  

⚫ 3Data Expert 16.0: STL and VRML repair examples document includes 
more advanced model repair operations with 3Data Expert. Estimated 
completion time with 3Data Expert 2 hours.  

The tutorial documents and the geometry files for the tutorial examples are found 
in the Tutorials folder and its sub-folders (GeomFiles, Tutorial 1, Tutorial 2, etc.) in 
the 3Data Expert installation directory.  
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Lesson 1 – Learning the Graphical User Interface  

The Generic Support command is operated through a set of toolbars. The toolbars 
allow both generating the supports automatically based on predefined parameter 
files as well as manual editing of supports for improved surface quality or increased 
robustness of the build.  

Generating supports automatically 

With this example we will just generate the supports using the automatic support 
generation process: We select the predefined support parameter file and generate 
the supports in “black box” mode.  

The support generation is started by inputting a file needing supports into the 
Model Tree. We will first 

- open a test file supp-demo1.3de into 3Data Expert with File Open 
command. The file is stored in the tutorials/GeomFiles directory under 
the 3Data Expert installation in Program Files directory. 

- accept the proposed units by pressing OK 

- press Print   in the Operation Mode window  

 

-  you will see the model stored in the Model Tree 

 

The example file contains a model with hole, surfaces with different surface angles 
as well as some local minima. The support generation will create sufficient support 
at the flat areas, around area edges as well as below the local minimum points.  

Let’s now start generating supports to the example model: 

- select the model in the Model Tree 
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- Give the command Print Preparation > Supports > Generic Support 
or press Supports button in the Print Preparation Tab 

 

A Print Configuration setup has been automatically loaded and contains the default 
support parameters for your environment: 

 

For more information about the Print Configuration and workspace, please refer to 
lesson Positioning Parts in the Tutorial 1 - Working with 3D Models document. In 
this tutorial we will specifically study the support structure generation parameters. 

 

The Graphical user interface toolbars for support generation appears:  

 

We recommend that you position the different support generator toolbars as 
given in the image above. This will leave the Viewing Toolbar and especially the 
Viewing Planes Toolbar (X, Y, Z views) visible.  

There are three toolbars: Create supports, Display supports and Edit supports. 
The functions are divided between the different toolbars according to their 
names.  
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Anyhow, this time we will just generate the supports using the automatic support 
generation. The supports are generated according to the parameters given in the 
Print Configuration. Then 

- Press Create button in the Create supports toolbar to create all areas 
and supports for the plate model 

 

 

First the command checks that all parameters are consistent with each other. 
Press Ok or Yes to the appearing confirmation and report dialogs (if any appear) 
to continue the support generation. If necessary, the support parameters are 
adjusted by the system to ensure concise STL structure generation.  

After a while the supports are generate and appear in the graphics area. 

 

 

You can investigate the supports visually with the middle mouse rotation, middle 
mouse zoom and other graphical viewing commands.  The red edge line around 
a supported area means that this specific edge is not supported by the part itself, 
while orange edges are supported by the part. Depending on the supported/not 
supported edge, the support itself can be further from or nearer to the given 
edge.  

The support area with lighter green color and marked with the red point is 
currently selected as active area in the support area list (1. support area).  

Finally, we store the generated supports in the Model Tree.  
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- Press OK button in the Create supports toolbar to store the supports 
into the Model Tree. 

After a while the supports are verified and stored in the Model Tree: 

 

 

Examining the first supports 

The generated supports have several properties which are important for correct 
build of a part with an AM system. The selected parameter set produced supports 
with the following properties: 

 

- The supports are solid. This allows to use supports for any AM system 
(DLP, metal, stereolithography) by providing enough strength and/or 
heat dissipation from the part with metal processes. Open (zero 
thickness) support structures can also be generated by simply modifying 
a parameter via the parameter editor (to be shown late). 
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- The supports are connected to the part via teeth. This makes it easier to 
remove the supports from the part after manufacturing. The user has full 
control to the teeth size via the parameter editor. Additionally, dovetail 
shape can be generated on the teeth for controlling the breaking point 
for the teeth accurately. 

- The supports follow the profiles of the supported areas. This prevents 
delamination at the support area edges with minimum amount of 
supports 

- The supports are only generated to areas requiring supports. With this 
example, we only generate supports to surfaces with smaller than the 
22-degree threshold angle to the vertical plane. The diagonal area in the 
middle has a 40-degree angle with the horizontal plane, thus not needing 
supports: 

 

 

- The support teeth are generated under the local minima. In the original 
parts some areas of the down facing surfaces were slightly lower than 
the surrounding down facing area (left in the picture below). In the final 
result we can see that tooth tips are located exactly below the local 
minima (in red ellipses below right, clipping applied). It is essential to 
support the part from the lowest points to guarantee correct 
manufacturing of the part. 
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- The supports are generated from the part to the vat bottom Z = 0 level. 
You should always leave sufficient room between the part and the vat 
bottom for the supports. Also, the part must be in the positive space 
when supports are generated. If necessary, you can use Print 
Preparation > Move to Platform > Move positive command to position 
the part correctly before support generation:  

 

 

The supports for supp-demo1 can now be outputted for AM or sliced and then send 
directly for AM. These steps are described in the last Chapter 6. Outputting and 
Slicing Supports for AM.  

 

Additionally, supports  

- will separate from vertical areas with user given tolerance. This will 
ensure better surface quality 

- teeth can also be generated on the bottom of the support when an 
overhang area needs to be supported from the part surface below the 
overhang area. This will also improve surface quality and make support 
removal easier: 
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In the example above the support area hitting the part underneath is shown red 
during the support generation mode. Sometimes you can try to avoid hitting the 
part below by using the Edit supports dialog Arch command. With Arch command 
you can manually bend the supports to avoid hitting the part below.  

 

Optimizing parameters for a selected support area 

The normal process for support generation is described above where the user 
automatically generates the supports based on the parameters defined in the Print 
Configuration. However, there may be situations where automatic support 
generation does not generate the optimum result. Some areas may require 
removal of extra support, supports for some area may require different solid 
thickness, another area may need to be split into separate areas and some model 
edges may require extra support. This and more can be achieved by using the 
interactive tools available with Generic support command toolbars.  

In the next example we will change the parameters for a specific area and then 
regenerate the area supports only. Once again,  

- open the supp-demo1.3de model and  

- press Create button in Create supports group 

The supports are now visible in the graphics area.  
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We will now take a quick look at the different display operations for the Support 
areas. The Display areas group will allow you to show either All areas or the 
Current area. All areas is the default value and by selecting the Current area you 
will see only the area which is selected in the support area list. Below we have  

- selected the Current area display  

- then select the first are in the area list.  

Only the first area is now displayed on the graphics area: 

 

- select All areas again 

The Current area group lets you select if the current area is shown with red point 
marker and/or bounding box corners. 

The Display mode group allows to show either Active areas or Discarded areas. 
Discarded areas are support areas which do not have any support, or which have 
been deleted by the user.  

The next group, Display types, allows you to set on display of different objects in 
the support generation. For example, you may only want to see the supported 
areas and supports, then  

- click Off the Original part display type selection: 
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You will see the support area triangles with orange hue and the area edges with 
red edge polygon. 

Or you may only want to see the supports, then  

- tick Off the Support area selection: 

 

Furthermore, you can only select to show specific support types, like Web, Chain 
or Point supports. We do not have an example of the Chain and Point types 
available now, but different visualization types will allow you to effectively 
investigate, edit and select areas for optimal support generation.  

Now, let’s select the second area from the support area list and change the 
parameters for that area.  

- Turn On all Display types and  

- select Display area selection Current. Then  

- select 2. support area in the list with the LMB (left mouse button): 

We will now see the part and the supports for the second area in the graphics 
area.  
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Finally, the last Display type selection Local minima shows the local minimum  
points with orange dot on the model. This is helpful if supports are added manually 
to ensure all minimum points are supported correctly: 

 

Let’s now have a closer look at the supports in the second area.  

- set Off the display of the Original part 

- zoom into the second support area in the graphics area 

 

We now want to change the density of the web in the second area. To start area 
parameter editing we first must select the correct Create supports type in the 
Create supports toolbar:  

- Open the Create supports dropdown list and  

- select the Create supports for current area selection: 
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The Edit area parameters button now becomes active: 

 

- Press the Edit area parameters button to open the Support 
Parameters parameter editor dialog. 

 

The Support parameters dialog includes several options to edit both common 
parameters for all supports or to edit parameters for specific support types. This 
time we will just edit one parameter for Web support types.  

- Press the Parameters… button in the Web supports group. 

The Web support parameters dialog becomes visible. 
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There are different options to tune the Web supports but now we just want to 
make the supports denser in the second area.  

- change the X spacing value to 1 mm 

- Press Apply button to “Create supports for the current area” as set 
earlier in the Create supports toolbar. 

We can immediately see that the supports for the second area change and 
become denser (zoomed closer to better visualize the difference): 
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You can edit any parameter, press the Apply button and immediately see the 
change on the screen (you may need to do some panning/zooming to see the 
support area). This will help you to quickly find and tune the correct parameters 
setting for different manufacturing processes and areas in a model.  

 

Alternatively, you can also close the dialogs one by one: 

- press OK to close the Web support parameters dialog 

- press OK to close the Support parameters dialog 

We are back at the Create supports toolbar and can  

- press the Create button to Create supports for the current area again.  

 

If we now  

- turn on the Display areas type All 

we can see that the two areas now have different density for the supports.  

 

 

You can now  

- press OK in the Create supports toolbar to save the supports in the 
Model Tree 

 

You will see the two areas generated with different Web density: 
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The Apply button in each parameter edit dialog allows you to test the changes to 
the parameters immediately after changing them in the parameter dialogs. This 
will enable quicker parameter tuning without the need to go back to Create button 
in the Create supports toolbar. The use of Apply button is explained in more 
detail in the Chapter 2 – Learning the support parameters.  

Generally, you can generate supports for one or all areas at a time. Also, you can 
only generate areas and add the supports later, automatically or by adding them 
manually with support editing. The Create support selections have the following 
meanings:  

Create all areas and supports 
recreates everything automatically, 
default choice. 

Create all areas recreates the areas 
requiring supports but leaves the 
actual support generation later.  

Create supports for all areas 
recreates the support for all areas 
available in the support area list 

Create supports for current area 
recreates the supports for the area 
selected in the support area list.  

 

 

Note: If Side or Arch supports are manually created in the model (see chapter 
Arch and Side supports), they will disappear if Create all areas and supports are 
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generated. If Create supports for all areas is generated a warning is issued. Arch 
supports may be straightened but Side supports are not affected when Create 
support for all areas is performed.  

 

Note: You can also use the compact Support parameters dialog when you get 
more familiar with the system and its parameters. With compact Support 
parameter dialog less graphics area is covered and 3D models can be more 
easily viewed.  

  

Compact Support parameter dialog is used 
when Use compact dial is On.  

 

In the image right the X spacing is selected 
for editing. When a parameter is selected in 
the dialog, the lower window shows the 
explanation text as well as the parameter 
image.  
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Lesson 2 – Editing support geometries manually 

The Generic Support command with 3Data Expert can generate supports to most 
models 

 

Adding supports manually 

Sometimes it might be necessary to add supports manually. With Generic 
Supports command the user can add four types of supports manually: Web, 
Chain, Point and Tree supports. 

First the area type to add is selected with the New area group on the Edit 
supports toolbar.  

 

Once again,  

- open the supp-demo1 model and  

- press Create button in Create supports group 

All supports are now visible in the graphics area. 

 

 

The slanted area between the two horizontal support areas does not have any 
support generated due to the 22-degree surface angle limit.  
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Let’s now take a closer look at the non-supported area and hide the created 
supports. In the image below we can see the result after 

- Web support display is turned Off (in red ellipse below) 

- the shaded+wireframe display mode is set on via the  icon in the 
Viewing toolbar 

 

We will first generate a new Web support area. For this  

- select Web from the New area group (in green ellipse above) 

- Press Add support button to start adding areas (in pink ellipse 
above) 

An area selection tool Area operation window becomes visible. We will use Area 
operations to select the triangles for new support area generation. Area 
operations allow you to select the area in several ways, please see the Fix Model 
> Edit Triangles command Online help for more information. This time we will use 
the Surface normal method available in the Mode selection list.  

- select the Surface normal mode (circled in green below) 

 

- click on a triangle in the middle of the area with LBM (below) 
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The whole slanted surface becomes greyed out and will show the triangles 
selected by the Surface normal criteria.  

 

 

These triangles will form the new area when we press the OK button in the Area 
operations dialog.  

- press OK in the Area operations dialog 

 

A new area appears in the support area list and the triangles in the slanted area 
are shaded with support area color. The new area is also selected in the area list. 
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Now we are ready to generate the supports for the newly created area.  

- turn On the Web support type in the Display types group, if Off 

- select Create supports for current area in the Create supports group 

 

- press Create button in the same group 

The supports are created for the new area using the currently available support 
parameters for Web area. 

You will see the new support below the slanted area, as seen in the next image. 
(Note: you may need to increase the Support angle parameter to 40 deg, described later 
to get a full grid below the middle area) 
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Let’s now add some Chain supports and a Point support on the slanted area. 
You can now press Cancel in the Create supports toolbar to quit this exercise.  

Restart again with  

- open the supp-demo1.3de model (or continue with already inputted 
model) and  

- Print Preparation > Supports > Generic Supports 

- press Create button in Create supports group with Create all areas 
and supports selected 

The support toolbars and all supports are again visible in the graphics area. 

Let’s again take a closer look to the non-supported area and hide the created 
supports. In the image below we can see the result after 

- Web support display is turned Off 

- the shaded+wireframe display mode is set on via  icon 

 

We will now generate new Chain support areas. For this  

- select Chain from the New area group  

- Press Add support button to start adding areas  

- use the hair cross and LBM on the graphics area to select two points 
on the surface as seen below (Alt+LMB would select a triangle corner 
point). If you make an error, you can undo with the ESC key. 

 

 

Also, the real-time Help window gives advice on what mouse button and 
keyboard key commands are available: 
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- use the RMB button to accept the new Chain support definition 

- and the Chain support is generated: 

 

 

We can also add a Point support area in the slanted area.  

- select Point support type in the New area group 

 

- press Add support to start adding Point supports. Select a point in the 
middle of the slanted area with LMB as seen below (Alt+LMB would 
again select a triangle corner point) 

 

- when ready, press RMB to add the Point support area into the 
support area list 
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Now we have defined two new areas in the support area list, and they are 
automatically generated when RMB is pressed. This happens when the Create 
New area automatically setting is turned on in the Edit > Preferences > Supports 
tab: 

 

If automatic generation is not set, you need to generate the new support areas 
separately. For this we will select the Create supports for all areas in the Create 
supports group, if not already selected. 

 

- select Create supports for all areas in the Create supports list 

- press Create button and supports for new areas become visible 
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Now supports for all areas have been regenerated. Currently we can see only the 
new Chain and Point supports because Web supports ha been turned Off in the 
Display types group.  

- set Web supports type back On in the Display types group 

and you will see all the supports in the graphics area.  

 

The green lines indicate the location of the Chain supports and the yellow cross 
shows the location of the Point support.  
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Deleting supports manually 

 

There are more tools available in the support toolbars 
which allow you to Delete Whole areas and Area details, 
Join areas and Split areas.  

In this exercise we will delete a whole support area 
as well as details inside another support area. 

 

  

Let’s now do a couple deletions from the supports generated in the previous 
chapter. We will first delete the recently added area, the Point area.  

- select the 4. support area in the area list (either from the list or by 
clicking the area triangle on the model with LBM) 

- press Delete button in the Delete area group (as in the image above). 
A message appears: 

 

- press Yes to the Delete the current support area request 

The Point support disappears from the support area display. However, it remains 
in the support area list for subsequent recovery, if necessary. 
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Now let’s delete some details from the existing support areas.  

- First select the 1. support area and zoom closer to it.  

 

Then  

- Press Delete details button in the Modify support group 

 

- the software goes into support detail deletion state. You can select as 
many web points indicated with small red cross as needed with the 
LBM. Selected points are indicated with small dots and line (1 selected 
in the image below). If necessary, press ESC to cancel a selection. 
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- When all necessary web points are selected, press RMB to delete the 
points from the support geometry.  

The selected points are immediately removed from the support geometry and the 
system returns from detail selection state.  

 

 

After the selected points are removed there is no possibility to Undo the deletions 
anymore. If necessary, the supports for the given area must be Created again.  

Similarly, you can delete points from the newly added Chain supports: 

- select the 3. support area from the area list (display on the Current 
area for clarity) 

- press the Delete details button 

- select chain tooth points with LMB by clicking a triangle close to an 
edge point 
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- press RMB to delete the selected points. The selected points are 
immediately removed from the support geometry 

 

 

Delete area details help cleaning the support geometry in case of unnecessary 
points, or to prevent surface areas below the supported area to be destroyed by 
the supports. Of course, you must be careful not to delete too many support points 
to be able to correctly build the part.  

Finally,  

- press OK in the Create supports dialog to store the supports into the 
Model Tree 

 

 

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 33 

Applying Arch command to support geometry 

When building complex parts with AM, the supports many times must be built 
starting from the actual part. Supports added to an overhang area must be built on 
top of an up-facing surface in the part. This will lower the surface quality on areas 
where the supports are built.  

Generic Support Arch command helps to move the supports away from up-facing 
areas in the part. The user can graphically drag the support geometry into new 
location away from the part or to a less critical area of the part.  

In this exercise we will use a simple part to demonstrate the use of Arch support. 
Start by  

- input the test model supp_demo3.3de  

- start Generic Support command 

- press Create button in the Create supports dialog 

 

You should see the following result on the screen: 
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The support for the upper overhang area is hitting the part surface below. This is 
indicated by red support color.  

We will now move the support away from the up-facing surface. First 

- select the 2. support area (red) 

- press the Arch button in the Edit supports dialog 

 

The software will display the arch support preview: 

 

The preview shows the outline of the support geometry. The outline will help to 
position the Arch support correctly. The Create support dialog Help window will 
give context sensitive help on the possible operations:  
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We will first select the arc point, i.e. the bend point of the Arch support. The point 
is in the middle by default, and it can be located anywhere on the vertical orange 
line.  

- first click on the bend position on the line with LMB, preferably 
higher than the given middle point 

- move graphically the bend point using LMB until a suitable position 
is found. The Grid displayed in the image will help to position the support 
root at the XY plane. 

 

- when a suitable position is found, press RMB to recreate the support 
in the given location 

 

 

In the new location the support will not hit the actual part. The surfaces in the 
finished part will be smooth without support marks.  

Note: Do not quit the Generic Support command with this model yet, we will 
continue the next exercise with the current situation.  
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Adding Side support 

The part supported in the previous exercise is relatively high when compared to 
the thickness. The support of the upmost overhang area starts to support the part 
only in the final phases of the build. This may cause bending or other defects in 
the part, caused the recoating process required for layer-based manufacturing.  

A Side support can be used to support the part from vertical or slanted walls which 
normally do not require supports. These supports will add robustness to the build 
assembly (part + supports) and/or more quickly dissipate heat from metal 
processes.  

We will continue with the result of the previous exercise. First take a view from the 
other side of the part and turn on shaded+wireframe display:  

 

 

Also, you need to select the Chain support type in the New area group, as seen in 
the picture above.  

Now we are ready to make the Side support structure using the Chain support 
type.  

- press the Add side support button  

- draw the Chain support polyline from the part surface as seen in the 
image below. Click on the consecutive triangle edges with LMB. Press 
ESC to undo in case of errors. 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 37 

 

 

- when the polyline is correct, press RMB to accept the polyline. The 
side support polyline and triangles are displayed on the part 

 

- press Z projection button ( ) to take a view from up 

- show the Side support root point with the LMB on the XY plane. The 
side support preview is displayed on the graphics area 
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- press RMB to accept the bottom point (or ESC to undo and reset) 

- press X projection button ( ) to take a view from front 

 

- press with LMB on the orange preview middle line to indicate the 
bend point for Side support 

- and move to correct location with LMB+dragging 
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- press RMB when ready to generate the Side support 

 

The added Side support geometry will increase the robustness of the build 
significantly.  

During the Side support drawing we were using Z and X projections. The drawing 
and dragging can also be done in 3D view but many times it is more accurate to 
take projection views for support drawing operations.  

You can now  

- save the supports into Model Tree by pressing OK in the Create 
supports dialog 

Note: When the supports are stored into the Model Tree they are checked for errors 
when solid supports are used. This may take some time due to the Arch supports 
which cause more triangle-triangle intersection checks than normal supports.  



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 40 

 

 

In the above example, the Side supports were based on Chain support type. Chain 
supports are normally created to down-facing sharp areas and lay relatively 
horizontal. Thus, it is a good practice to draw the Side support when using Chain 
type horizontally, otherwise the supports may have some artifacts in the result (not 
a proper solid).  

 

Adding Tree support 

Let’s now have a look at the last support type, Tree supports. Tree supports are 
created by drawing a tree like net with tree root and branches.  

The tree support is generated in phases: First we will select the top of the tree on 
the part surface. Then the tree root is show on the XY plane. After that we can add 
branches, move points and tune the tree thickness in different levels.  

The Tree parameters are set through Tree supports parameter dialog accessible 
via Support parameters dialog: 

 

As an example we will use a simple ring-like geometry. The supports for this model 
could also be done using the Arch support, as seen in the image below but this is 
left as an exercise to the reader.  
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We start the Tree support generation by inputting the ring model.  

- input the test model supp_demo4.3de  

- start Generic Support command 

- press Create supports to generate automatic supports 

This time we will delete the 2. support area from the part and generate a less 
invasive Tree support instead. The 2. support area hits the surface below and we 
want to avoid that. Also, a Tree support will potentially use less material. 
Sometimes it can be sufficient to use an Arch support to bend the support away 
from the surface below.  

 

- select 2. support area and delete it using Delete whole area 
command in Edit supports dialog 
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- select Tree type in New area group 

 

- and press Add support button and Create tree supports dialog 
appears:  

 

 

This dialog has all necessary commands to draw a Tree support. Also, the help 
text window gives context sensitive help to take through the tree generation easily.  

It is a good idea to first take a “slanted” view to the model. This will help to position 
the tree tip to the correct position. 

- rotate the view so that it is visible from the bottom (almost, see below) 

- press Add trunk icon to define the tree trunk 

 

- show the location of the tree tip on the model with LMB (red cross 
in the image below) 
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- take a view from the Y axis direction with  

- show the location of the trunk root with LMB, preferably below the 
XY plane, as seen in the picture below 

 

- press RMB to accept the root location (or ESC to reposition) 

 

 

Now all tools in the Create tree supports toolbar become active and we can start 
adding branches to the tree.  
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We will generate two new branches to the tree. Once again, we take a view almost 
from the bottom to be able to position the trunk tips correctly.  

- first press Add branches icon  

- then click on the model surface with LMB (red cross in the image 
below) 

- then click on the tree trunk with LBM to add the branch point (blue 
point in the image below) 

 

Now we have added one branch on the tree. The second branch is added similarly, 
first click on the model surface then on the same location on the tree as the 
previous branch point on the trunk. You should have something similar to the 
image below. You can always Undo by pressing ESC.  

 

 

- when all branches are added press RMB to accept the new branches 

You should have a tree similar to the image below. Now you can either move the 
points with the  

 

icon or you can add wanted thickness to selected nodes in the tree with the 

 

icon.  
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The Tree thickness in the loaded parameter set is very small, 0.5 mm. We want to 
adjust the tree thickness in different nodes for more robust build.  

Fist set the Tree radius to 4 mm 

 

Then  

- press icon  to change the tree radius at a point 

- and select the tree root node. The new radius for the tree root will be 
displayed on the tree preview 

 

- change the Tree radius to 2.0 mm 

- and click the middle branch with LMB. The middle branch will have a 
new diameter 2.0 mm 
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The new radius values will be used for the tree generation instead of the original 
0.5 mm value set in the Tree support parameter dialog.  

- press RMB to quit changing tree radius 

- press OK in the Create tree supports dialog (or RMB) to store the 
new tree in the support area list and to generate the supports geometry 

And the Tree support is ready. 

 

- press OK to store the supports in the Model Tree 

 

The ring and the supports are now ready to be manufactured with suitable AM 
system.  
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The above examples were all done using solid support structures. This mostly for 
a better viewing experience: zero-volume open support plates do not perform 
visually well. These examples can be done using the corresponding “open” 
parameter files available in the installation package. 
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Lesson 3 - Learning Support Parameters 

The Generic Support command with 3Data Expert can automatically generate 
supports to most models. For the automatic process to succeed with different 
processes, like metal or DLP, a suitable set of parameters needs to be given to the 
program. The software installation comes with several Print Configuration 
parameter files tuned towards different processes. Anyhow, the user must check 
that the given parameters and generated support geometries are suitable for the 
receiving AM system. 

Opening and saving support parameter files 

The support parameters are part of a Print Configuration which contains the 
parameters required to prepare the model for a specific AM system. When you 
start 3Data Expert, the Print Configuration set defined as your default is loaded. 
The Print tab shows you the most common parameters and contains the button 

 to open the configuration editor (if you cannot see the Print tab, type Shift-F8): 

 

 

- Click   to open the Print configuration editor: 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 49 

 

Because we are now interested in support parameters, we will not go into details 
of this dialog here. It suffices to point out the with the Load and Save buttons you 
can manage your own copies or backups of the Print configuration settings. Also, 
even if support parameters are built inside the Print configuration, it is possible to 
separately Export support parameters of the current Print configuration, as well as 
Import a previously (or elsewhere) saved support parameter set. This functionality 
allows you to test the parameters without losing original settings. 

- Close the Print configuration setup window with the Cancel button 

Now let’s start with the same example as before. Once again,  

- open the supp-demo1 model 

- Print Preparation > Move to Platform > Move Positive with 10, 10, 10 

- Start the Generic Support command 

The first Parameters group in the Create supports toolbar includes file Load and 
Save options. These buttons do the same as the similar buttons in the Print 
configuration setup window: they allow you to switch between Print configuration 
sets and make backup copies of your current parameters. 
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The predefined parameter files which come with the installation are installed in the 
System folder. These files cannot be overwritten without administrator rights. 

 

Editing Common support parameters 

The support parameter editing is done via a set of parameter dialogs. There are 
currently 6 different dialogs for different support types. The first, Common 
parameters, affect all support types. Three support specific parameter dialogs, 
Web, Chain and Point support parameters, affect the different support types 
respectively. If set, the Tube supports and Tube support parameters, allows to 
convert all above support types to tubes. The Tubes supports are useful for 
medical applications, like titanium teeth implants. Tree support parameters 
currently define the parameters for manual Tree support addition (later an 
automatic conversion of all supports to Tree is implemented). 

All support parameter dialogs include both image and textual explanation on each 
parameter. This makes it very easy to understand and modify the parameters for 
an optimal support result. In the sequel we will mostly rely on the parameter 
explanations given in the dialogs and concentrate to describe the effect of each 
parameter change.  

The effect of a parameter change is best observed by pressing the Apply button 
on the bottom of each parameter dialog. Pressing the Apply button all parameter 
changes are updated immediately to the support preview in the graphics area. You 
can use different viewing commands (pan, zoom, rotate) when the parameter 
windows are open to take a better view to the part and supports.  

With low-resolution screens it might be better to press OK on each parameter 
window and execute the Create command when the graphics window is fully 
visible. Some of the parameter dialogs are quite large and may hide the part and 
supports. Alternatively, you can use the compact dialog mode. 

Continuing with the supp-demo1 model in the Generic Supports state,  

- press Create button in Create supports window 

- set Create supports setting to Create all areas and supports, if not 
already set 

- press Edit Parameters button in the Create supports toolbar 

- press Common parameters in the Support parameters dialog 

- zoom in/pan to have unobstructed view to the part and supports, as 
seen in the image below 

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 51 

 

Your screen should now look more or less as seen above, the model and supports 
on the right-hand side of the screen and support parameter dialogs on the left-
hand side of the screen.  
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We will first demonstrate the effect of the most important Common support 
parameters. Support angle parameter defines which areas will be supported or not. 
If the angle between the surface and horizontal plane is bigger than the given 
angle, the part is considered self-supporting and no support is generated under 
the surface.  

- set the Support angle parameter to 45 degrees  

 

- press the Apply button in the Common parameters dialog 

- press Yes to the recreate request (if it appears): 

 

The result on the graphics changes immediately, as seen in the image below. The 
slanted area in the between the two horizontal areas is no longer considered self-
supporting and it is added to support areas. Now there is just one large support 
are below the part. At least 45 degrees is a recommended support angle for most 
metal based AM processes.  

 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 53 

Now let’s try the Non-supported edge offset parameter. This value defines how far 
the support following the area edge can be located from the outer edge of the 
support area. The default value is 0.5 mm,  

- change the Non-supported edge offset value to 1.0 mm 

 

- press Apply and Yes to the recreate request 

The support structure outer profile is now moved further away from the support 
area edge. In the left-hand image below we can see the 0.5 mm Non-supported 
edge offset result and on the right hand side the 1.0 mm offset. The edge offset 
value depends heavily on the receiving AM system, varying between 0.1 to 1.0 
mm. Metal processes tend to require smaller values than other AM processes due 
to strong forces induced to the part during the cooling. If the support profile is too 
far from the edge, delamination or cracking may occur in the final part.  

  

 

Finally, let’s change all supports to open supports. By default, the supports 
generated with the default parameter set are solid, i.e., they form a watertight body. 
Some processes may not require solid supports and suffice with open support 
structure.  

- tick Off the Create solid support setting: 

 

- press the Apply button 

- press Cancel to the Common parameters dialog (do not risk modifying 
the Print configuration) 
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- press Cancel to the Support parameters dialog 

- rotate the result to see the open support structure as seen in the image 
below 

 

- press OK to Create supports toolbar to exit and store the supports to 
the Model Tree 

- if this warning dialog appears, choose Yes: we do not want to save 
the parameters this time 

 

You will soon see the open support structure stored in the Model Tree.  
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Editing Web support parameters 

Web supports crate a regular grid shaped support structure below the supported 
area. The grid size, thickness and teeth size can be tuned with the support 
parameter dialogs. Also, a profile which follows the support area edges at a given 
distance can be generated around the grid support structure. The latest version 
allows to convert Web and Chain supports into crisscross structure.  

Now start again with the familiar supp-demo1.3de file. Once again,  

- open the supp-demo1 model and  

- start Generic Support command  

- press Create button in Create supports group 

- zoom into the higher end of the support structures, make sure you have 
unobstructed view to the model higher support area (with a hole) 

- select the 2. support area from the area list with LMB 

- set Create supports setting to Create supports for current area, if 
not already set 

 

- press Edit area parameters button in the Create supports group  

- press Parameters button in the Web supports group in the Support 
parameters dialog 

Your screen should now look more or less as seen below, the model and supports 
on the right-hand side of the screen and support parameter dialogs on the left hand 
side of the screen. You can pan, zoom and rotate the view as necessary.  
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We will first modify the density of the Web support grid.  

- change the X spacing to 1 mm (applies currently to Y spacing, too) 

 

- press the Apply button in the bottom of the Web support parameter 
dialog 

The support grid immediately becomes denser. The grid will now provide a 
stronger support, which may be necessary to avoid bending of the part or to 
dissipate heat from the part during the AM process.  

 

 

Let’s next change the how the teeth intersect the part.  

- set Up overlap and Down overlap to 0.0 mm 

 

- press the Apply button 
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The support teeth do not anymore intersect the part surface. With some processes 
it may be necessary for the supports to intersect the part to get strong enough 
contact between the part and the supports. On the other hand, some processes 
may produce better result if the support just touch the surface, or even with small 
distance if overlap value is set to < 0.0 mm (i.e., a negative value).  

In the left picture the overlap parameter has the default value, in the right one the 
overlap values are 0.0 (view from above, top of the model clipped off): 

  

 

Let’s now make a sparser grid with bigger teeth. 

- first set the X spacing to 3 mm 

- then press Apply button in the Web support parameters dialog to 
update the grid 

- then press the Parameters button in the Tooth parameters group 

 

You should have the screen as shown below. The Tooth parameter dialog is visible 
and the sparser grid is shown on the graphics area.  

Now fill in new values to teeth parameters.  

- set Teeth distance to 0.5 mm, as seen in the image below 

- set Teeth base length to 0.5 mm 

- set Teeth tip length to 0.3 mm 

- set Teeth height to 2.0 mm 

- press Apply in the Teeth support parameters dialog 
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You should see updated teeth structure on the sparse grid structure. The software 
automatically calculates and modifies the most suitable teeth distance against the 
grid size and generates as dense teeth as possible. Zooming into the contact 
region, on the left before tooth parameter modifications, on the right with tooth 
parameter changes applied: 

 

You can now exit all support parameter dialogs by pressing Cancel. This will 
prevent touching the Print configuration settings, but still store the modified 
parameters for the area 2. support area we selected when starting the parameter 
editing.  

- press Cancel to Tooth support parameters dialog 

- press Cancel to Web support parameters dialog 

- press Cancel to Support parameters dialog 

- zoom and rotate to see both support areas for the part 

The two support areas now have different support structure parameters applied. 
In the start we selected the 2. support area and pressed the Edit area parameters 
button. All changes are now done only to the area 2. and the area 1. has remained 
in the original state.  

 

 

- press OK to save the supports into Model Tree. The result (clipped from 
positive X direction is shown in the picture below). 
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With 3Data Expert it is easy to define different support properties for different areas 
in the part.  

 

 

Note: You can also save the current 
support version to the Model Tree by 
pressing Save button in the Create 
supports dialog. This will not exit the 
support generation: it only stores the 
current supports in the Model Tree for 
subsequent comparisons. The saved 
result is named with “Sn:” prefix and 
made passive not to become visible. 
After exiting the support generation, 
you can make the saved support object 
visible with RMB Make active 
command.  

 

 

Editing Chain support parameters  

Chain supports are used for supporting thin or sharp downfacing edges in the part. 
With the support parameters we can tune the tooth size and cross plate distance 
and cross plate distance from the support top.   

To investigate the Chain support parameters, we will first generate a simple cube 
and rotate it for Chain support generation at the sharp downfacing edges. Also, we 
will Refine the box for some manual Chain support additions.  

- empty the Model Tree with File > New command 
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- create a box geometry with Create Geometry > Box command with 
the parameters below (20x20x20mm box): 

 

- press OK to create the box into the Model Tree 

- select the Box Shell in the Model Tree 

- give command Transform > Rotate > Numeric to rotate 20 degrees 
around X axis, press OK 

 

- give command Transform > Rotate > Numeric to rotate 20 degrees 
around Y axis, press OK 

 

You should have the following box in the Model Tree (viewed from Y axis direction): 
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- move the part to the positive space with Print Preparation > Move 
to Platform > Move positive command using the parameters below 

 

You should now have the box in the right place for support generation. 

 

 

Let’s now generate the Chain supports below the sharp edges of the box.  

- select the Box Shell model in the Model Tree 

- give command Print Preparation > Supports > Generic Supports 

- press Create button in the Create supports group  

 

You will see the support result in the support area list (one Chain support area) 
and in the graphics area: 

 

Before going to edit the Chain support parameters, let’s add some stability to the 
build by adding manual support to the third slanted edge. 
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- now select the Chain type in the New area group,  

- then press Add support… button to select two points from the box 
edge as seen below. Makes sure you select the points as close to the 
edge as possible. If you make a mistake, you can Cancel each step with 
the ESC key. 

 

- when ready press RMB to save the new Chain area to the support 
area list and to generate the support geometry 

 

Both areas are now regenerated, and the result is displayed on the screen.  

 

With this example we show how you can add more support to increase the stability 
of the part build.  

Now rotate and zoom the model on the graphics area so that you will have an 
unobstructed view to at least one of the support areas. Then 

- press the Edit Parameters button in the Parameters group to start 
editing parameters for all support areas at once 

- press the Parameters button in the Chain supports group 
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- change the value of the Spacing to 3 mm in the Chain support 
parameters dialog 

 

- press Apply in the bottom of the parameter dialog 

The distance of the cross plates at the Chain support has increased. This 
parameter allows to create stronger (denser) or weaker (sparser) Chain supports, 
depending on the receiving AM process. Especially metal processes should have 
dense enough spacing to avoid support bending while creating them. Similarly, 
increasing the Cross-length parameter in the parameter dialog will add more 
stiffness to the supports.  

 

 

- next change the Distance from support top value to 2 mm 

 

- press Apply 

The distance of the Cross-plate top is now increased.  
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The value depends once again on the receiving AM process. Some processes can 
build higher (DLP, stereolithography) thin wall supports than some other processes 
(metal) without bending them. The smaller the distance from the top the stronger 
the support will be.  

Up overlap, Down overlap and Tooth parameters work the same way as the 
corresponding support parameters with Web support type, described in the 
previous chapter.  

Note: When you are adding the points for Chain support, make sure you always 
pick them from downfacing surfaces. Otherwise, the results may be unpredictable.  

Close the support parameter windows with the Cancel buttons. 

 

Editing Point support parameters  

We could continue Point support parameter editing with the model created in the 
previous example for Chain supports. However, to have a refined triangulation of 
the cube 

- restart with supp-demo2.3de file 

You should have only the box in the Model Tree: 
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Start the support generation with the Generic Support command 

- give command Print Preparation > Supports > Generic supports 

- open the Support parameters dialog via Edit parameters button in 
the Create supports toolbar 

- press Common parameters button in the Support parameters dialog 

- edit Support angle parameter to value 10 degrees 

 

- press Apply button in the bottom of the Common parameters dialog 

 

You will now see a single Point support below the Box Shell. Due to the 10-degree 
Support angle, no other area below the Box Shell is considered to need supports 
this time.  

We will now go through some basic Point support parameters.  

- press Cancel to close the Common support parameters dialog 

- in the Create supports window, choose Create supports for current 
area 

- press the Edit area parameters button (to modify current area only) 

- press the Parameters button in the Point supports group  

 

- first change the number of Plates parameter to 6 
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- press the Apply button 

You will see the Point support shape to change in the graphics area. In the right-
hand image we you can see the original Point support with 3 plates. Because the 
Solid supports in On in the Common support parameters the support is a solid tube 
instead of three open plates crossing each other. When we increase the number 
of Plates, the point support tube becomes smoother due to more plates, i.e, the 
subdivision of the tube outer surface becomes more accurate.  

  

- now change the Plate length to 3mm 

- press the Apply button 

The Point support is now 3 mm in diameter: 

 

 

- next turn Off Generate up teeth and Generate down teeth 
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- press the Apply button 

You will see the tooth on top of the Point support disappear, as seen in the image 
below.  

Tooth parameters, Up overlap and Down overlap parameters work in the same 
fashion as was described in the Web support parameter editing chapter previously.  

 

- Close the parameter windows with the Cancel button. 

- Exit support generation with Cancel 

- Close the model: File > Close 

 

Generating Tube supports 

Tube supports allow you to convert the Web, Chain and Point supports to small 
tubes. This kind of supports have several uses, like supporting teeth implants for 
medical applications.  

Start again with the original supp-demo1.3de file. Once again,  

- open the supp-demo1 model and  

- give the Generic Support command  

- press the Create button in Create supports group 

You will soon see the familiar support structure on the graphics area: 
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- Press the Edit Parameters button 

- Tick On the Generate selection in the Tube supports group at the 
bottom of the dialog 

 

- Press Apply in the Support parameters dialog 

Soon you will see the Web, Chain and Point supports changed to tube like 
structures, as seen in the image below. The Tubes are generated more or less to 
the same locations where the teeth to the first support were located. The Tubes 
are disconnected from each other and also stretched to the vat bottom. On the 
right we see the tube supports (with web supports on the left, for comparison): 

   

 

The tube parameters are set though the Parameters button in the Tube supports 
group. The parameters allow you to change the Tube wall thickness, Tube 
smoothness, and Tube top and bottom size parameters, as seen in the image 
below. If the Tube thickness is set to 0, a solid tube is generated (closed at both 
ends).  
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The Tube diameter and distance is set according to the teeth size defined for the 
Web supports. Teeth base length will define the diameter of the tube and Web 
supports Teeth distance will define the average distance between tubes (the 
distance value is modified to fit the optimal number of teeth between the Web grid 
points and the Profile edge points). You must be careful not to use too big a Tube 
thickness when compared to the Diameter = Teeth base length or Top/Bottom 
diameter, otherwise you might generate self-intersecting support structures.  

 

 

You may now start again the Tube support generation and change the different 
values to see how it affects the generated Tube supports.  

- Finally, Close the parameter windows with the Cancel button, to keep 
the Print configuration setup intact. If you use the Ok button to close the 
windows, you can still bypass the Print configuration modification, when 
asked. 



3Data Expert 16.0: Tutorial 4 - Generating Supports for AM 

 Page 70 

- When ready, press OK to the Create supports toolbar to save the tube 
supports into the Model Tree 

 

Compact parameters dialog 

You can use the compact Support parameters dialog when you get more familiar 
with the system and its parameters, or if you have a low-resolution display. With 
the compact Support parameter dialog less graphics area is covered, and 3D 
models can be more easily viewed.  

 

The Compact Support parameters dialog is 
used when Use compact dial is On.  

 

In the image right the X spacing is selected 
for editing. When a parameter is selected in 
the dialog, the lower window shows the 
explanation text as well as the parameter 
image.  
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Generic Support improvements with version 14.0 

Generally, there have been several improvements in the Generic Support 
command internal functionality: better area filtering, vertical wall separation, 
smoother profile edges etc. Additionally, some new functionality has been added:  

 

Helical area supports 

Helical parts and areas can now be supported normally without splitting the area 
in two.  

  

 

Move details end point re-evaluation 

The Move details command in Edit Supports dialog has been improved. The 
support point selection is now less crowded and an option to re-evaluate the end 
points of the moved support point has been added. In the left-hand image below 
the available selection points area show with green crosses. In the right-hand 
image the new Re-eval end pts parameter is shown.  

  

The effect of re-evaluating the end points is shown below. The automatic support 
generation produces the result in the leftmost image below. The support goes 
along the vertical support at the bottom of the image. To create better surface 
quality the support point at the area border can be moved manually. The middle 
image shows the movement without re-evaluating the moved support vector end 
points. Some overlapping of the supports and the part remain in the lower areas. 
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When the Re-eval end pts is used (in the right-hand side picture) the support does 
not affect the vertical surface in the bottom anymore.  

   

 

Similarly, with the Arch support modification, the original support geometry is 
used by default. This enables you to delete some details from the support and 
then perform the Arch operation and keep the modified support geometry. If Re-
eval area supp (Arch) is set, all support vectors are re-evaluated during the Arch 
generation and previous edits are lost. 

 

More consistent support geometry 

There are less “stray” single point supports and the supports are generally 
smoother and better connected than with previous versions. This will help to 
keep the used material clean and allow better reuse of the material.  

In the image below we have version 12.0 solid supports on the left and new 14.0 
solid supports on the right-hand image: 
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The same applies to open support structures, less stray components in the 
supports. Version 12.0 on the left and 14.0 on the right-hand side image:  
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Lesson 4 - Outputting and slicing supports for AM 

There are two ways to output the generated supports for AM. Either both the part 
and the supports can be stored as STL files on the hard disk, or they can be 
sliced and outputted as slice files for AM. Current slice file output formats include 
.cli and .sli (EOS format). Slices can also be saved as bitmap files, as explained 
later. 

Saving supports STL file 

The STL file output is simply done with Edit > File Save As command. You can 
either save the part and the supports separately, one at a time, or they can be 
saved at once. The two methods need slightly different settings. 

 

Saving STL files separately 

- In File > File Options, set the Common and 
STL save options according to the picture on 
the right. 

- Select the part in the Model Tree: 

 

- Start File > Save As. Set STL as the output 
file type. Note that the default file name only 
contains the supp-demo1 part of the shell 
name. Feel free to use a different file name. 

 

- Select the supports shell: 

 

- Start File > Save As. Note that the file name 
now contains the s_ prefix (as specified in 
Edit > Preferences > Supports), to distinguish 
it from the part file:  
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Saving STL files together 

- In File > File Options, set Separate files to 
Yes and Separate files name type to Add 
index (as shown in the picture to the right). 

- Select the root level All in the Model Tree: 

 

- Start File > Save As. During file save, answer 
Yes to the question: 

 

- We will get the following output files: 

 

 

 

The STL files can later be given to AM system software for slice generation.  

 

Saving support and part slices 

Both the part and the supports can be sliced in 3Data Expert and then sent to the 
receiving AM system software. This involves the use of two different commands, 
Print Preparation > Slices and Print Preparation > Fix Slices commands.  

If you do not have a supported model available, please generate the supports to 
the automatically as shown in the Chapter 2. After the supports are generated, 
slicing is started by selecting the part to be sliced in the Model Tree: 

- Multi-select 1. Supp-demo1 (Verified) and supp-demo1 (Support) in 
the Model Tree 

 

- give command Print Preparation > Slices and a parameter dialog 
appears. Use the default values (retrieved from the Print configuration), 
but in Advanced section, set Output to disk off: 
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- press OK to start the slicing 

After a while the slices are displayed with the graphics area using the Slice Preview 
toolbar; the lowest-level slice is drawn in the preview. Both part and support slices 
are now in the last shell in the Model Tree. 

 

 

We have generated slices for both the part and the support with slice thickness 0.1 
mm. You can preview the slices using the Slice preview toolbar commands: 
Change the color of the slices, use the horizontal slider to manually go through the 
slices, Show animation to see all slices automatically and go to a specific slice 
level with Current slice group settings.  
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Visual checking shows that the slices are ok and should be ready for output to AM 
processes, as seen in the picture below. We have selected both slices for display 
at once, and 0.1 mm filling to ensure that the contours are closed. 

 

You can now close the Slice preview toolbar with the upper right hand corner Close 
icon.  

 

Originally, we have generated solid supports with the default Print configuration 
settings, which produces solid support data. For this reason, we may want to make 
sure that all slices form closed polygons too. This is checked and fixed with Print 
Preparation > Fix Slices command. This will fix both the part slices and the support 
slices.  

- select the slice shell in the Model Tree 

- give command Print Preparation > Fix slices and parameter dialog 
appears 

 

- accept the default tolerance and press OK 

 

You are now ready to output the slice data for AM. There are two ways to store 
the data, either as contour data (.cli, .sli) or as bitmap data (as BMP, JPEG or 
PNG files).  
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The contour data is saved simply by using the Edit > File Save As command. 
Select each slice shell separately and output them in the suitable slice format, 
CLI or SLI (EOS format). Remember to name the part and support slice files so 
that they can be separated from each other, like part.sli and part_s.sli, where “_s” 
suffix depicts the support slice data.  

For bitmap output you need to generate separate bitmap file. This is done with 
Print Preparation > Export slice bitmaps command. When the command is given, 
the Slice Image Export dialog appears:  

 

 

With the dialog you can set several properties of the output data. You should 
normally use the default parameter values (taken from the Print configuration), 
but the output can be tuned, for example if the files will be prepared for a different 
AM system: 

- Output Whole model vs. Current Group. Normally you will select Whole 
model to output both part and support slices into the same ZIP file 

- By default, output image size is set either directly or via resolution (as 
defined in the Print configuration), but you can change the method 

- Select image type PNG, JPEG or BMP (note that JPEG option can cause 
compression artifacts in the output images) 

- Select black and white (one bit per pixel), RGB (24 bits per pixel) or 
grayscale (8 bits per pixel) images 

- Invert inside vs. outside color (dark inside/white outside or the opposite) 

Select the output directory and output ZIP file name. Then press OK, and the 
slices will be stored into the given directory and file: 
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The preview images of the slices above show the support as a web like structure 
and the part as solid white area, as seen in these details of two non-consecutive 
slice bitmap files: 

 

 

Slicing supports and parts into one file 

With earlier 3Data Expert versions it was necessary to merge all part and support 
shells into one shell before the Print Preparation > Slices command if both part 
and support slices had to be stored in a single file. 3Data Expert 16.0 allows slicing 
of several part and support shells at once into the same slice file. Actually, it is 
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recommended not to merge the components as that would remove the Label text 
string attached to the separate shells for Production Screenshot, for example.  

First load the Print Configuration file GenericDLP-modified.pcpar (saved in Tutorial 
1) to get a workspace suitable for our example model. 

We will start with the 12-cellphones.3de file (no need to move the model this time): 

 

If you wish, you can turn on/off the platform display with the  icon.  

We will first create supports to the cellphone models.  

- Select Model Tree root All 

- Create supports with Generic Support command (if in doubt of 
parameter state, you can reload the Print configuration): 

- Press OK to save the supports into the Model Tree 

- After a couple of minutes you will have all the supports checked and verified 
in one shell of the Model Tree: 

 

Now you can  

- first select root All and Slice all components at once. 
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- give command Print Preparation > Slices.  

You probably get two consecutive warning messages (shown below). The software 
first tells that the supports shell is in warning state, then that the numbers of part 
and support shells selected differ. This is correct because we have generated all 
supports at once to all separate parts earlier. 

- press Yes to both questions:  

  

 

Finally we will see the Slice STL dialog. This time we choose a slightly different set 
of parameters: 

- Turn on Output one file 

- Turn off Use model directory 

- Choose a different output Directory (use the Browse… button), unless you 
want to save the slices into the tutorials folder 

- In the Advanced section, turn on Output to disk 
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The Output to one file parameter will cause both the part and support slices to be 
stored in the same output file cellphone.cli (the Supp slices field is then greyed 
out). This also allows to use Union support – part contours option.  

Press OK to start the slicing into the CLI contour file. 

Previewing Slice data 

We can now input the slice file into the 3Data Expert for inspection. 

We will use the File > Insert command to input the slices into the Model Tree and 
keep the original 3D model.  

 

 

Press Open to insert the slice data in the Model Tree. After a while we can see the 
Slice preview tool open with the first slice level visible in the graphics area (hide 
the other shells to see the slice preview only):  

 

 

Normally it is best to look at the slices from positive Z axis direction: press the  
icon to change the viewpoint (you may need to fit the slices by double clicking on 
the slice shell in the Model Tree): 
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We can also turn off the platform display off with  icon.  

Now you can start looking at the slices either indvidually with the slider in the 
Current slice group or start animation in the Show animation group to browse 
through all slices automatically.  

To check the quality of the slicing it is possible to use Fill and Spacing parameters 
to simulate the hatching process with AM system software. You can set the density 
of the hatchign freely but remember that the smaller the spacing between the 
hatches the longer it takes to generate them.  

Below is an example of a level 116 with Fill and 0.1 mm Spacing:  

 

You can use all viewing commands like Zoom to look closer to  any region on the 
slices. Even 3D viewing with the original model is possible. First select Model Tree 
root All to show the 3D model and then re-select the slice group. Slice colors can 
be changed to differ them from the part colors. 
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The Slice preview tool is turned on automatically when you select slices  (cellphone 
(Contours)) shell from the Model Tree and turned off when something else is 

selected in the Model Tree. You can also press the  icon, select View > Slice 
Preview from the menu, or close the Slice Preview tools window on the right hand- 
up corner Close icon. After that you can Copy/Paste/Delete etc. the slice shell.  

 

Lesson 5 – Additional tools for support generation 

There is a set of additional tools to aid the generation of optimal support for a 
part. These tools include Transformation commands, like Rotate and Move, as 
well as Center of Gravity calculation tools. For example, a part can be rotated so 
that the selected surface is facing exactly upwards for best surface finish or the 
Center of Gravity is set to the lowest point to minimize the bending forces to the 
part during the build. 

 

Center of Gravity calculation  

The Dimensions > Center of Gravity command is used to calculate the 
corresponding point in 3D. For the calculation the bounding box of the part is 
divided into 100x100x100 cells and the calculation is based on this subdivision.  

 

 

The Center of Gravity command can be run either on a single shell or root All to 
calculate common center of gravity for multiple shells. If multi-selection is used, 
the point is calculated to the first selection.  
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Lesson 6 – Connect Tool 

The Connect Tool is used to add support struts between component details for 
added strength. Struts will prevent the model from warping during the AM or post-
processing. This lesson is for the Base module only. 

Connect Tool command 

Connect Tool in the Modify Faceted menu will allow to add connecting struts and 
tree-like structures between component surfaces. The connecting struts will help 
to keep the shape of the part during support removal and post-processing. For this 
example we use file 1-cellphone.3de file.  

- Input 1-cellphone.3de from Tutorial/GeomFiles directory 

- Bypass Operation Mode etc.  

 

- Select the cellphone (Repaired) shell from the Model Tree and  

- start the Modify Faceted > Connect Tool command.  

 

The Connect Tool command toolbar appears:  

 

 

You must first set the General Dimensions of the connectors, overall Diameter 1.0 
and Tip diameter 0.5. These will be stored to the connector tip and bend points 
during the connector creation.  

When ready  

- push the active Add strut trunk button .   

You will go into strut point addition mode.  
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- Show the strut start point (red cross) and end point (blue cross) on the 
component walls with LMB. Then press RMB.  

You can rotate the view during the point addition with the MMB (middle mouse 
button).  

 

 

- After the RMB is pressed, the connection strut main trunk is ready: 

 

 

Now you can accept and generate the single strut by pressing RMB or OK button 
in the Toolbar. Or you can continue to add branches to the strut tree. We will do 
that.  

- Now press the active Add branches to strut  button.  

- Then show first point on the component feature with LMB (red cross) and 
the second point on the strut main trunk with LMB, as seen in the image 
below:  
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When ready  

- press RMB to accept the branch. Note, you can always cancel the last 
operation by pressing ESC button.  

You will see the branch added to the trunk structure.  

 

 

We will finally add two additional split points to separate the trunk end points from 
the trunk body. This is needed to have the tip diameter separated from the main 
trunk diameter more clearly (otherwise there would be continous radius change 
from the bach point in the middle towards the end points).  

- Press  button to Add point to split strut. Show two points with the LMB 
as seen in the image below (blue crosses). When ready adding points press 
RMB:  
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We are now ready creating the connect strut structure and will press RMB again 
or OK button in the toolbar to actually generate the triangle model for the struts.  

 

 

The connector strut is now stored in the Model Tree. It is a separate shell from the 
part component and there are different ways to use it with the cellphone part.  

One normal way is to use Boolean commands, like Modify Faceted > Multiple Join, 
to combine the cellphone and the strut into one component. This way the connector 
will be produced with the part building parameters on the AM machine and would 
possibly have supports generated along the part support generation.  

 

 

Another way is to mark the connector as being part of support structures (with Print 
Preparation > Supports > Mark Supports command, please see dialog below). This 
way the connector will be sliced and processed as part of the support structures.  
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Lesson 7 – Sand Supports 

The Print Preparation > Supports > Sand Supports command is used for 
generating sand support structures for sand-based AM systems.  Sand supports 
form a supporting plate below the part to avoid breaking the part during clean-up 
and transportation to customer site. This lesson only applies to the 3Data Expert 
Base module. 

 

Sand Support generation 

In the sequel we will explain how to make a supporting plate to a thin cooling pipe 
geometry. We will use cooling_pipe.stl file as an example.  

We must first open a suitable Print configuration for the sand supports. 

Shift f8 --- pic --- import --- save 

− First, start with a fresh environment: File > Close (or File > New) 

− If the Tools Window is not visible, press Shift+F8 to open it, then 
choose the Print tab 

− Open the Print configuration setup 

− For this example, changing the workspace size is sufficient: choose the 
Workspace category, modify the maximum values to: 

Box X max = 1000 

Box Y max = 600 

Box Z max = 500 

− Press OK to accept the new workspace size. (It is not necessary to save 
the workspace, because it will only be used for this example.) 

We can then proceed to model handling: 

− input the cooling_pipe.stl model from Tutorials / GeomFiles 
directory.  

− run through the Fix Model and Auto Repair process. 

− Go directly to the Print mode.  
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− Move the cooling_pipe into a correct position (positive space) with 
Print Preparation > Move to Platform > Move Positive command with 
the parameters below: 

 

 

The part where the supports are to be generated must be selected before the 
command.  

− Select shell cooling_pipe from the Model Tree. 

− Start support generation with the command Print Preparation > 
Supports > Sand Support. 

The dialog box for Sand Support parameters now opens. Each parameter includes 
a comprehensive text and image explanation.  

First you will have to set the values for the support generation before executing the 
command. In the image below you can see the proper values to run the command 
for cooling_pipe.stl file. Especially, set the  

- Sand support top level to 25 mm, in the middle of the pipe part in Z 
direction, 

- Support box offset to 10 mm and 

- Sand support base plate top level to 0 mm (this is no longer needed) 
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This set of parameters should get you started with the support generation. Anyhow, 
the exact values depend on the machine and the used resins. Testing, your own 
expertise and machine documentation will tell the correct values for each 
machine/material type. 

− Start the support generation by pressing OK. 

A percentage bar appears, and soon you will see the supports displayed on the 
screen. 

 

 

The part and the supports can now be selected with multi-selection and outputted 
into a single file for slicing with the machine vendor's software. 

 

 


